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User Guide
This section gives an overview of the Voyager application. It describes the user interface components, how to search and view your data,
and various processes that can be run to help speed up day-to-day tasks. 

User Interface
The Voyager display is composed of a few basic components, including a textual search box, a toolbar containing some helpful menus, a
search results area, an overview map, and filters, all of which will be explained in this section.

Search Box

The search box is used for text queries and is an easy way to find items in the index.  For more information on how to search using the
text search box, go to .Query Syntax
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Menu Toolbar

The toolbar contains the navigational and functional menus within Voyager: , , , . It also displays the number ofHome Sort View Tools
results in the current search and provides the ability to navigate through the results pages.

Home Menu

The Home menu has four options: , , and . Voyager Search clears any previous search,Voyager Search Saved Searches Lists Processing
brings the interface to the main page and shows all indexed data. Saved Searches takes you to a list of previously saved searches.  Lists
displays the various lists you have created.  Processing displays a history of the process tasks that have been run.

Shortcut
The Voyager GIS Data Discovery logo at the top of each page also clears your search and brings you back to the main
page.

Sort Menu

The Sort menu has a list of sorting options so you can see results in the way that makes most sense to you.  This list is configurable via
the  dialog and also contains an option for reversing the direction of the search results. Configure Sort
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View Menu

The View menu enables a user to determine how they want the data to be displayed. There are five view options: , ,  Summary Grid Map,
and  The View tab also allows a user to determine and set configurations for , , , , and .Table Report Filters Display Table Reports Sort

Tools Menu

The Tools menu provides several things a user can do with the data that Voyager has discovered, including: , Save This Search Open
, ,  , and . RSS Feed Open Results With Process Results, Add Results to List Export Result List
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Search Results

Below the toolbar, the search results are displayed in the type of View the user has chosen ( , , , , ).  In thisSummary Grid Map Table Report
case, the results are displayed in the Grid View.

Overview Map
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The Overview Map to the right of Search Results displays the extents of the data on a map.

Color Meaning

Green spatial extent that was searched (by drawing a polygon on the map)

Blue The extent of all results that match the given query

Red The footprint for each result that is displayed on the current page. Note that this is not  matching results.all

Filters

Below the Overview Map is a list of Filters, which are used to refine a search. The default filters are: Type, Subtype, Format, Geometry
Type, Properties, Author, Spatial Reference, File Extension and Location, but they are . The Show Inverse Option filters onconfigurable
the opposite value of any existing filter.

Within the Filters section, Field Statistics shows the total size, average size, and deviation for all files in the index. 
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Depending on the user's permission level, Admin Options may be available from the Filters section. The following actions can be taken
on the :current set of results

Remove from the index, with the option of also deleting the corresponding thumbnails, metadata, and layer files
Add results to the discovery queue, which re-indexes the items immediately
Show the underlying query

Watch Video Online
http://voyagergis.com/doc/current/Filters

Searching for Data
Searching for data can be done in different ways. Voyager provides , which can be used to narrow your set of results to just the datafilters
you are looking for. Another option is to do a textual search, using the . Once you have found what you are looking for, thesearch box
results can be  by different fields.sorted

Watch Video Online
http://voyagergis.com/doc/current/Searching for Data

http://voyagergis.com/doc?id=1573434
http://voyagergis.com/doc?id=1572874
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Query Syntax

By default Voyager searches over all text (including metadata) for matching items. Results that match the title or path are ranked above
results matching any other text. To customize the default field weights, see Query Settings

In addition to the default behavior, Voyager supports explicit operators and field selection 

Operators

OR

The OR operator is the default search operator. This means that if there is no operator between two terms in a search, the OR operator is
used. The OR operator links two terms and finds a matching document if either of the terms exist in a document. 

For example, to search for documents that contain either "Florida highways" or just "highways" use the query:

"Florida highways" highways

or

"Florida highways" OR highways

AND

The AND operator matches documents where both terms exist anywhere in the text of a single document. 

For example, to search for documents that contain "rivers" and "lakes" use the query:

rivers AND lakes

Fields

Voyager supports fielded data. When performing a search you can either specify a field name, or use the default search which uses
many fields.
You can search any field by typing the field name in lowercase followed by a colon ":" and then the term you are looking for.
Searching by field names only produces results that match the particular field specified. 

For example, to search for  any documents with "Rivers" in the name field and "Florida" in the path field, use the query:

name:rivers AND path:Florida

Note: The field is only valid for the term that it directly precedes, so the query

name:major cities

Will only find "major" in the name field. It will find "cities" using the default search which uses many fields. 

To search for 2 or more terms in a field name, quotes around the text are required. For example, to search the name field for "major
cities", use the query:

name:"major cities"

Search by path
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Paths in voyager can either be searched for using the standard field selection operator ":", or a special "=" operator that matches folders
explicitly.

Using the standard "path:" syntax, the query is looking for words in the path. For example:

path:Desktop

Will return items with "Desktop" in the path.

Using the "=" operator will find files explicitly in a folder. For example:

path=F:\Desktop\NJ DEP\NJ100mhillshd\nj100mhill

Will find all results under this folder. Aditionally, the  syntax triggers a special  UI.path= Path Navigation

Wildcards

Voyager supports single and multiple character wildcard searches within single terms. 

To perform a single character wildcard search use the "?" symbol. 

To perform a multiple character wildcard search use the "*" symbol. 

The single character wildcard search looks for terms that match that with the single character replaced. For example, to search for "text"
or "test" you can use the search 

te?t

Multiple character wildcard searches looks for 0 or more characters. For example, to search for counties or countries, you can use the
search: 

count*

Note: * or ? are not valid as the first character in a search string

Escaping Special Characters

Voyager supports escaping special characters that are part of the query syntax. The current list special characters are: 

+ - && || ! ( ) { } [ ] ^ " ~ * ? :

To escape these character use the \ before the character. For example to search for (1+1):2 use the query: 

(1+1)\:2

Lucene Query Syntax

Text searches in Voyager are based on Lucene style syntax. So users can use operators, specific field names or wildcards to produce
the results they require.

For more information about Lucene style syntax please refer to the following link: 
http://lucene.apache.org/java/3_0_1/queryparsersyntax.html

http://lucene.apache.org/java/3_0_1/queryparsersyntax.html
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Sorting Results

The Sort tab has a list of sorting options so you can see results in the way that makes most sense to you.  This list is configurable via the 
 dialog and also contains an option for reversing the direction of the search results. Configure Sort

Watch Video Online
http://voyagergis.com/doc/current/Sorting Results

Path Navigation

Path Navigation is new to version 1.2.3 in Voyager.

This allows filtering simply by clicking any of the folder or sub-folder locations from the path on the Detail Page.

Watch Video Online
http://voyagergis.com/doc/current/Path Navigation

http://voyagergis.com/doc?id=1573468
http://voyagergis.com/doc?id=1573698
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Query Syntax
To enable this feature manually, enter "path=C:\path\to\your\data" in the search box

Search Result Options
Voyager provides options to a user when a thumbnail of an individual search result is clicked in the Summary, Grid or Map Views.  These
options are:  Show Detail Page, Show Preview, Show Metadata, Open With, Locate on Disk, Process, Add to List, Remove From List,
Extent, and Exclude item.

Detail Page

The Detail Page reveals many details specific to this individual search result. By default, the details displayed include basic attributes like
the name, path, theme, place, etc. What information is displayed can be configured via the Configure Display option under the View
menu.

  

The detail page also shows links or relationships between the item and any other items in the index.  For example, if the dataset is used
in an MXD or Layer File, the MXDs or Layer Files will be displayed as links in the "USED BY" section.  
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Conversely, MXDs and Layer Files display the items within them in a tree structure, so users can see which Feature Layers and datasets
are used in the document and can explore them directly from the DATA section or via the links in the MXD structure. 

The relationships between items in a database are also captured and displayed. For example, databases show links to all of the items
within them. Feature datasets show which database they are in, as well as the datasets they contain. And datasets have links to their
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database and feature datasets.

Show Metadata

Displays the item's metadata using the style selected from the dropdown menu. This Additional, custom style sheets can be added to this
list. 
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Show Preview

Shows a larger, more detailed view of the dataset. 
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Open With

The Open With option allows the user to open the individual search result in a variety of desktop applications, including ArcGIS desktop
applications, KML viewer, or the Window Default Application.

Locate on Disk

Opens Windows Explorer and navigates to the individual search result on disk.

Process

This option opens the choices for processing the individual search result on desktop or server. The process choices are Clip and Ship,
Convert to KML, Create Default Metadata, Copy Data or Mosaic. For more detailed information about the processes, see the Processing
section.
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Add to List

This gives the user the ability to add the individual search result to either a new list or an existing list.

For more information about lists: Working with Lists

Remove From List

This gives the user the option to remove the individual search result from a list.

For more information about lists: Working with Lists

Extent

This gives the user the options to:

Zoom to Extent -Zooms the map into the extent of this item
Query Within Extent - Performs a spatial query and returns all items whose extent falls completely within the current item's
extent.
Query Extent Intersection - Performs a spatial query and returns all items whose extent intersects the current item's extent.

All results are reflected in the overview map in the upper right-hand corner of the window.

Exclude Item

This option allows the user to exclude an individual search result from the search.
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RSS Feeds

This tool allows a user to open search results in an RSS Feed, which will automatically notify them if something in their results changes.

Watch Video Online
http://voyagergis.com/doc/current/RSS Feeds

See also: OpenSearch, RSS

Working with Views
Once your index is created, you can view the items in the index in various ways, allowing you to visualize your information in the most
appropriate way. Views are used to display the data in a layout of your choice ( , , , , or Summary View Grid View Overview Map Table View

), with a configurable set of fields displayed and providing a useful set of filters for further refining your queries.Report View

http://voyagergis.com/doc?id=1573105
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Display Options

The View tab enables a user to determine how they want the data to be displayed. There are fire view options: , , , Summary Grid Map
 and . Table Report

Watch Video Online
http://voyagergis.com/doc/current/Display Options

http://voyagergis.com/doc?id=1573091
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Summary View

The summary view displays a few pieces of information about each item, along with the thumbnail for the item. 

To configure which fields are displayed, see Configure Display
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Grid View

The grid view displays each item as a thumbnail only. When you hover over a thumbnail, more information about that item is displayed. 
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Map View

The map view displays the relationship between the data and where it lies spatially. 
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Table View

The table view displays results as a list. This is useful for comparing results based on a property, such as the size of the item in Bytes or
the time it took to index the item. 

 

To configure which fields shown in the table, see Configure Table

Tip: When displaying results in the Table View a user has the ability to export the result list in CSV, SHP or XML. This
option is offered at the bottom of the page.

Alternatively use the  tool.Export Results List
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Report View

The report view that generates graphs based on the configurable set of filters used to narrow search results. Graphs include pie and bar
charts, are interactive and will work in any web browser (without the need for special plug-ins such as Flash or Silverlight). 

 

To configure the charts and graphs, see Configure Reports
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View Configuration

Views are fully configurable, allowing you to change the filters, reports, sort, display, and table options.  Any user with the
''configure_views'' permission can create custom views.

Configure Filters

This option allows the user to select fields that will be used to filter query results. The filters are used to show a subset of the data, giving
the user a better idea of the types of data in the index and to narrow down exactly what they may be searching for. 

Additional filters can be added from the set of Fields on the left, or filters can be removed from the active Filters list by using the left/right
arrow buttons in the middle of the window to move things into and out of the list. The display order the filters can also be changed using
the up/down arrow buttons. 

Default fields: type, subtype, format, geometry type, keywords, properties, author, spatial reference, version, theme, file extension and
location. 

Watch Video Online
http://voyagergis.com/doc/current/Configure Filters

http://voyagergis.com/doc?id=1572922
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Checkbox Style

This filter style uses check boxes to select from multiple values at the same time. It effectively acts as an "AND" filter.

Select Style

This is the default filter style – it shows each of the available options and allows you to click on a single value to refine your search. Note
that once a value is selected the filter will be applied and other filterable values will no longer be available.  This effectively acts as an
'OR' type of query.

Show Additional Catalogs

To view data from both local and remote catalogs, select the Show Additional Catalogs option.
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Remote catalogs must have been previously configured by the administrator. See Federated Catalog Search

Configure Display

This option allows the user to select which fields will be displayed for each result. The items chosen here will all be displayed in the Detail
Page for the item, but some will also be visible in the Summary View, when hovering in Grid View, and in Map View.

You can add or remove display fields, or change their display order using the arrow buttons in the middle of the window.

Default fields: theme, place, keywords, author, product, column and abstract. 
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Configure Table

This option allows a user to choose which columns will be displayed in the Table View. You can add or remove display fields, or change
their display order using the arrow buttons in the middle of the window. 
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Configure Reports

The reporting view displays a graph for each of the fields used to filter query results (as seen on the right side of the Voyager interface).
To hide or remove a report the appropriate field can be added or removed from the list of filters. 

Configure Sort

This option allows a user to choose which fields are available for sorting query results.

You can add or remove display fields, or change their display order using the arrow buttons in the middle of the window.

Default fields: relevance, name, path, bytes, modified date, row count, column count, page count, time to index. 
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Saved Searches

After configuring searches, it is good to save them, so you can use them in the future.

This tool allows a user to save their search results, name the search, give it a description and come back to that data at a later time or
use it as the default search.

Watch Video Online
http://voyagergis.com/doc/current/Saved Searches

http://voyagergis.com/doc?id=1572936
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For a complete list of your Saved Searches, go to the Saved Searches page from the menu.Home 

Default Search Configuration

A default search can be configured and saved, so all users will see the same filters, display fields, table layout, and default view.  To
create a default search, the options to be used as default. Once everything is configured correctly, go to the "Tools" menu andconfigure 
select "Save This Search...".  Enter a Title and Description for the search and select the "Use As Default Search" option.
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To set the default search to a Saved Search that was previously configured, go to the  page and on the "Options" menuSaved Searches
select "Show Edit Options".  Edit any of the existing Saved Searches and select the "Use As Default Search" option.

Processing
This tool allows a user to run the results of a search through a task or process, for example: , , Clip and Ship Convert to KML Create

, , etc. The user decides whether to run their process on the desktop or a server.Default Metadata Mosaic

If the option to  is chosen, the processing happens on the server and the user can download theProcess Results on Server
results when it is finished.
If the option to  is selected, the processing happens on the user's desktop machine and the resultsProcess Results on Desktop
are accessible directly.
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Server vs Desktop

The same processes can run locally on the desktop or remotely on the server. The desktop option is only enabled if Voyager Desktop is
installed on the client machine.  The server option is only enabled if the license level is Workgroup or higher.

If a process is run on the desktop, the output is accessible directly from the local machine via the "open" link under "Output".

If a process is run on the server, the output is added to a zip file that can be downloaded via the "download" link under "Output".
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To run geoprocessing processes on the Server, an ArcGIS Server license must be available.
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Standard Processes

Voyager delivers useful processing tools 'out-of-the-box' however, the framework is designed to be extendable to your specific needs. For
more information, see developer guide Custom Processes

Clip and Ship

Clip and Ship gives a user the ability to extract a region of the results into a distributable bundle.  Select the region to clip, browse for an
output location and click Execute. 

Watch Video Online
http://voyagergis.com/doc/current/Clip and Ship

http://voyagergis.com/doc?id=1572970
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Convert to KML

This gives the user the ability to convert a search result to KML. Select a region to clip, browse an output location and click Execute. 
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Create GeoPDF

Create GeoPDF gives a user the ability to create a GeoPDF containing a layer for each of the results. Select the region to clip, browse for
an output location, choose a name for the new PDF and click Execute.
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Create Default Metadata

This process allows a user to create default metadata for data that does not currently have any metadata associated with it. 

Create Raster Mosaic

Create Raster Mosaic allows a user to create a mosaic dataset from raster datasets in the index. Browse for an output location and click
Execute.

Copy Data

This process allows a user to copy data from one location to another. 
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Mosaic

This process allows a user to combine imagery into a single raster.
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Process History

The Process History Page displays two links to previously run on either the Desktop or Server. Processes 

ArcMap Toolbar
The Voyager ArcMap Toolbar provides seamless integration with ArcGIS Desktop. It allows you to search the Voyager index using text
and spatial queries as well as drag-and-drop search results from Voyager Desktop into ArcMap.

The toolbar comes bundled with Voyager Desktop. It is an option that can be installed at the end of the installation process. See the 
 section for more details.Voyager Tools Installer

ArcMap integrations works on ArcGIS 9.2, 9.3, 9.3.1, and ArcGIS 10.

The toolbar can be found in the list of ArcMap toolbars under "Voyager". Enabling it will allow the user to search the Voyager index by
entering a text-based search, like "cities" or "roads", into the Voyager Toolbar textbox, or perform a spatial search by drawing an extent in
ArcMap using one of the Voyager Search tools: Search Using Intersection or Search Within.  Results of any query from the Voyager
ArcMap Toolbar are displayed in the Voyager window.  You can also launch Voyager manually using the Launch Voyager button. 

Drag to ArcMap

Search results found in Voyager can be added directly into ArcMap by simply dragging the item's thumbnail into ArcMap.  The item can
be placed at a specific location in the ArcMap Table of Contents by dragging the item over the TOC until the correct location is found, and
then dropping it.  The combination of easily finding data using Voyager directly or via the ArcMap Toolbar, then creating your map using
the drag-and-drop feature will allow users to create maps faster than ever.

Search From ArcMap

Draw box in ArcMap and get results in Voyager. 



68Voyager 1.3.0 - July 2011

Working with Lists
Lists hold search results that can be used at a later time, much like a shopping cart in an online store.

Watch Video Online
http://voyagergis.com/doc/current/Working with Lists

Add Results to List

This tool gives a user the option of either adding their data search results to an existing list or creating a new list. Lists are useful when
you are building up a set of data that you want to do something with later on (much like adding things to a shopping cart).  Once a list has
been created, all the results in that list can be run through one of the processes, opened in ArcMap, exported to a CSV file, etc. 

http://voyagergis.com/doc?id=1573109
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New List Option - Items can be added to a new list: 

Existing List Option - Items can be added to an existing list: 
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Export Results List

This tool allows the user to export the list of results to different formats, including: CSV, XML, or even to a Shapefile. The fields that will
be exported to the list is configurable. A few default fields have been set: id, name, path, and format. The user can choose other fields
that make sense, or remove any of the default fields using the left/right arrow buttons in the middle of the dialog. The order of the fields
can also be changed using the up/down arrow buttons. The user also has the option of adding the output to a zip file when it is complete.

Watch Video Online
http://voyagergis.com/doc/current/Export Results List

http://voyagergis.com/doc?id=1573407
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